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Setting up Primavera integration with Estimate 

Primavera integration with Estimate requires that you have an existing implementation of Primavera 
v6.x or P6 in your network environment. This includes but is not limited to the following:  

• A Microsoft SQL Server or Oracle Database for Primavera (Primavera Database Server)

• A named user license for the Primavera Integration API. (Contact Primavera to obtain this
license.)

Prior to installing the Estimate Primavera Integration Server, you will be required to install additional 
applications and define configuration settings to complete the integration with Estimate. 

Server Configuration and Setup 

While all server components can be installed on the same physical server, they can also be installed on 
separate servers. There can be three different servers when setting up the Primavera integration with 
Estimate:  

• Primavera Database Server – This server runs the Microsoft SQL Server or Oracle database
service and holds the Primavera Project Management (PM) database.

• Estimate Primavera Integration Server – This server contains the Java Developer’s Kit (JDK), the
Java Runtime Environment (JRE), Primavera Integration API, InEight Estimate Primavera
Integration Server service, Java - .NET Bridge components, and the JNBridge license file.

• Estimate Server – This server contains the Microsoft SQL Server database instance for Estimate
(HDBID), and as a result, the Microsoft SQL Server HDBID service and the InEight Estimate Server
service.

The diagram below illustrates how the Primavera Integration with Estimate would look if the 
deployment method chosen were to occur on three separate servers. 

NOTE: 

Primavera integration with Estimate is supported with Primavera v6.x, P6 v7, and P6 
v8 - P6 v15.1. When installing and configuring Primavera, it is necessary that all 
Primavera applications installed on your environment are the same version. This 
includes the database server, client application, and Integration API. 
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Determine the TCP/IP Port Number of the Primavera Database 

The Estimate Primavera Integration connects to the Primavera database using a host name and port 
number. You will need to know what port number to use in a later setup step.  

You can see the port number by viewing Help > About in a Primavera client: 

1. From the main Primavera client menu, choose Help > About.
2. Click on the System tab.
3. Locate the Bre Database line.

4. The port number displays after the server (host) name and before the database instance name.

• In the following example, the port number for the Microsoft SQL Server Primavera Database
Server is 49251:

o BRE Database: com.microsoft.sqlserver.jdbc.SQLServerDriver,
jdbc:sqlserver://server1:49251;database=pmdb; 8.0, INTERNAL_PLUGINS)

• In this example, the port number for the Oracle Database Server is 1521:

o BRE Database: oracle.jdbc.driver.OracleDriver,
jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=Server2)
(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)(SERVICE_NAME=XE))) (, 7.0,
INTERNAL_PLUGINS)

5. Document this port number, as you will need to know it in a later setup step. Click Close to exit
the About Primavera dialog.

Install the Java Runtime Environment (JRE) or Java Developer’s Kit 
(JDK) 

The integration of Primavera v6.x or P6 v7 with Estimate requires the Java Runtime Environment (JRE) 
to be installed on the Primavera Integration Server machine.  
The integration of P6 v8 - P6 v8.4 with Estimate requires the Java Developer’s Kit (JDK) to be installed 
on the Primavera Integration Server machine.  
If you are running 64-bit Windows, a 64-bit JDK is required.  
You can download the installation files from http://java.sun.com. 
At the server console where the Estimate Primavera Integration Server will be installed:  

1. Download the Java Runtime Environment (JRE) or Java Developer’s Kit (JDK) installation file.
2. Double click on the installation executable to begin the installation process.
3. Proceed through the installation screens, accepting default options until the installation is

finished.

NOTE: 

Primavera v6.x and P6 v7 require Java Runtime Environment (JRE) version 1.4 or 
above. P6 v8 - P6 v8.4 require the i586 version of the Java Developer’s Kit (JDK) 
version 1.6.0_23 or above. The Primavera integration with Estimate will not function 
correctly with older versions of Java. 

http://java.sun.com/
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Install the Primavera Integration API 

The version of the Primavera Integration API application that is required for Primavera to interact with 
Estimate will depend on the version of the Primavera database server that you have installed. The 
installation files for this application can be found on your Primavera installation media. 

NOTE: 
As mentioned above, you must install the same version of all Primavera components. 
For example, if you have installed version 8.1 of the P6 EPPM database server, you 
will be required to install version 8.1 of the P6 EPPM Integration API. 

At the server console where the Estimate Primavera Integration Server will be installed: 

1. Locate the setup.exe file on your installation media for the Primavera Integration API. (If you
obtain the Media Pack from the Oracle e-delivery website, you will find the Integration API in
the Web Services download.)

2. Double click on the setup.exe file to start the installation process.
3. On the Welcome to the Primavera Integration API Installer screen, click Next > to continue.
4. If prompted on the Software License screen, select I Agree and click Next > to continue.
5. On the Installation Type screen, select Local Mode Packages Only and click Next > to continue.
6. Specify the location where you want to install the Primavera Integration API.
7. On the Select Components screen, check both Demo Applications and Integration API Javadoc.
8. If prompted, specify the location of the JRE or JDK that you installed above and click Next > to

continue.

o Example JRE Java.exe file location: C:\Program Files\Java\jre6\bin\java.exe

o Example JDK folder location: C:\Program Files\Java\jdk1.6.0_23

9. Click Next > and then Install to continue the installation.
10. On the Database Configuration screen, select either Oracle OR Microsoft SQL as appropriate,

and click Next > to continue.
11. In the User Name field, enter the Primavera database username (e.g., pubuser).
12. In the Password field, enter the Primavera database password (e.g., pubuser).
13. In the Database Name field, enter the Primavera database name (e.g., pmdb or

pmdb$primavera). For Oracle, enter the SID (e.g., XE).
14. In the Database Host Address field, enter the IP address or DNS name of the server where the

Primavera database resides.
15. In the Database Port field, enter the port number you documented above.
16. Click Next > to continue.
17. If you have an existing Primavera database configuration, you can select the existing

configuration or create a new one; then click Next > to continue.
18. Click Exit to complete the Primavera Integration API installation.
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Define the Timeout Setting and Expiration Check Rate for the Primavera 
Integration API 

At the server console where the Estimate Primavera Integration Server will be installed: 

1. From your Windows desktop, choose Start > All Programs > Primavera Integration API [version
No.] > Primavera Administrator.

2. Enter your privileged user name for the Primavera database (e.g., privuser).
3. Enter your password for the Primavera database (e.g., privuser) and click OK.
4. On the Primavera Administrator form, select the Configuration tab.
5. Expand the Primavera P6 Configuration folder (or your configuration name, if it is different) by

clicking on the + icon located to the left of the folder.
6. Expand the Services folder by clicking on the + icon located to the left of the folder.
7. Expand the License Service or Module Access Service, whichever exists, by clicking on the + icon

located to the left of the folder.
8. Triple click on the Epirationcheckrate node to edit it and change the value to 30s.
9. Click on another folder in the tree list to exit the field.
10. Further down the tree list, expand the Integration API Server folder by clicking on the + icon

located to the left of the folder. Then expand the RMI folder, also.
11. Triple click on the Session Timeout node to edit it and change the value to 24d.
12. Click on another folder in the tree list to exit the field.
13. Click the Save Changes button located in the bottom right corner of the form.
14. Click OK on the dialog, indicating all changes were successfully submitted.
15. Click on the X in the upper right corner of the window to close the Primavera Administrator.
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Set Up a Named User for the Primavera Integration API (Primavera v6.x or P6 
v7) 

At the server console where the Estimate Primavera Integration Server will be installed: 

1. Launch Primavera Project Management. From the main Primavera menu, choose Admin >
Users to open the Users dialog.

2. Highlight the Admin login name in the list of users. (Or, choose a special user designated for use
by the Estimate Primavera integration. This is the user that will be specified in Job Properties for
every job configured to send updates to Primavera. You can avoid permission problems by
making this user an “Admin Super User”. The special user does not need access to any module
besides the Integration API.)

3. In the bottom portion of the dialog, click the Licensing tab.
4. Select the Named User checkbox in the Integration API row.
5. Click Close to exit the dialog.

Set Up a Named User for the Primavera Integration API (P6 v8 – P6 v15.1) 

In a web browser: 

1. Launch the Primavera P6 Web Application. At the top of the screen, choose Administer > User
Access.

2. Highlight the Admin login name in the list of users. (Or, choose a special user designated for use
by Estimate Primavera integration. This is the user that will be specified in Job Properties for
every job configured to send updates to Primavera. You can avoid permission problems by
making this user an “Admin Super User”. The special user does not need access to any module
besides the Integration API.)

3. In the bottom portion of the dialog, view the Module Access tab.
4. Double click the Access checkbox in the Integration API row to check the box.
5. Click the Save toolbar button.
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Installing the Primavera Integration Server 

The Primavera Integration Server network component is required to allow for the dynamic integration of 
Primavera with Estimate. The Primavera Integration Server can be installed on a dedicated server or on 
a server that contains other Estimate applications.  

Estimate supports manual configuration of the Primavera Integration API (using "admin.cmd") to 
connect to multiple Primavera databases. This advanced configuration allows a single Primavera 
Integration Server to sync with more than one Primavera database.  

If your enterprise uses multiple Primavera databases in locations distant from each other, it is better to 
install multiple Primavera Integration Server services. Each must be installed on a different computer, 
and you must give them unique instance names.  

Optimize performance by locating the service instances locally with the Primavera databases to which 
they connect. Do not connect more than one Primavera Integration Server instance to the same 
Primavera database. 

NOTE: Java and the Primavera Integration API applications must be installed on each 
Primavera Integration Server. 

1. Start Windows as you normally would, then exit out of any programs that are currently running.
2. Launch the Estimate installer downloaded from the InEight website:
3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make

changes to your computer.
4. On the Installation Package screen, click the Install button to continue.
5. Click Install Estimate to continue.
6. At the License Agreement screen, select "I Accept the Agreement". Then click Continue to

continue.
7. If other Estimate client or server applications have already been installed on the server, select

Install on the Upgrade or Install dialog and click Next > to continue.
8. At the Components screen under Third Party Integration Components, select the Primavera

Integration Server checkbox, and click Next > to continue.
9. If you are installing the Primavera Integration Server on a server where no other Estimate

applications are installed, at the Select Destination Location screen, define the installation
folder where the Primavera Integration Server application will be installed. To accept the
default installation folder, you do not need to do anything. To define a different installation
folder, click on the Browse button and navigate to the desired folder. Click Next > to continue.

10. At the Ready to Install dialog, click Install to continue.

NOTE: If you are installing the Primavera Integration Server network component on a 
dedicated server, the Estimate Framework will also be installed. 

11. On the Estimate Configuration dialog, select the Primavera Integration tab if it is not already
selected.
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12. In the Paths data block:

• If you are using 32-bit Windows: Click on the Find Paths button to define the paths to the Java
Virtual Machine DLL file and the Primavera Integration API Folder. In the event that either of
the paths is not defined after clicking on the Find Paths button, you can click on the browse
button next to each path field to browse to the appropriate location.

• If you are using 64-bit Windows: Click on the Find Paths button to define the path to the
Primavera Integration API Folder. Then define your path for the Java Virtual Machine DLL by
browsing to the correct jvm.dll. Your path for the Java Virtual Machine DLL will be similar to
C:\Program Files\Java\jre6\bin\server\jvm.dll. With the Java JDK installed, your path for the
Java Virtual Machine DLL will be similar to C:\Program
Files\Java\jdk1.7.0_45\jre\bin\server\jvm.dll.

13. In the Java data block, define the maximum memory setting from the Predefined Value drop
down list or, click on the Custom Value radio button and define a maximum memory setting.
The Java memory setting defines how much you want to allow Java to use for the Primavera
integration with Estimate. The default value is 512.

NOTE: 

If you have not yet installed Java and/or the Primavera Integration API, click OK to 
continue the installation of the Primavera Integration Server. Once you have 
completed the installation of Java and/or the Primavera Integration API, you can use 
the Estimate Configuration Tool to open this dialog again and define the paths and 
Java memory settings. 

14. In the Instance data block, specify the Instance Name if more than one Primavera Integration
Server connects to the same Estimate Server. If you have only one Primavera database, this field
may be left blank.

15. Click OK to continue.
16. On the Attention dialog, click OK to continue.
17. At the Update Registry and Finalize screen, click Next > to continue.
18. Click Finish to complete the Primavera Integration Server installation and exit the setup

program.
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Using Microsoft Project as the Integrated Schedule 

Using Microsoft Project as the integrated schedule in Estimate provides you with a powerful and flexible 

project management tool that you can use to control simple or complex projects. It helps you schedule 

and track all your cost items, so you can stay on top of their progress. 

Define Microsoft Project as the Integrated Schedule 

1. From the main Estimate menu, choose Setup > Job Properties.
2. Click on the Schedule tab.
3. In the Integrated Schedule field, click on the drop down list button and choose Microsoft

Project.
4. If you always want to use Plug Days when updating Estimate from the schedule, select

the Always use Plug Days when updating Estimate from the schedule checkbox.
5. Click OK to close the Job Properties form.

NOTE: 

To make Microsoft Project the default integrated schedule for all projects, choose File 
> Library > Setup > Job Properties, select Microsoft Project in the Integrated
Schedule field on the Schedule tab, and complete the additional associated fields as
described above. This way, each time you create a new project in Estimate, Microsoft
Project will automatically be defined as the integrated schedule.

Defining Cost Item Roll Up Rules 

Your Estimate project may contain more cost items than you want to schedule. You may want to create 

a schedule for the project at a high level, rather than scheduling all the job's cost items. You determine 

that this can be accomplished by rolling up the cost breakdown structure to a certain level (e.g., level 3). 

When you do this, you will only see the cost items at the rolled up level (e.g., level 3) from the Cost 

Breakdown Structure in the schedule, and you can then proceed to schedule these items using the tools 

in Microsoft Project. 

Once all the rolled up level cost items have been scheduled and you update Estimate, the scheduled 

start and finish dates from Microsoft Project will be brought back into the Cost Breakdown Structure. As 

a result, all cost items lower than the rolled up level (e.g., level 3) in the Cost Breakdown Structure now 

inherit the start and finish dates of their superiors at the rolled up level (e.g., level 3). 

If you decide that a specific leg in the Cost Breakdown Structure needs to be scheduled with more 

detail, you have the ability to schedule specific legs at a level lower that the rolled up level previously 

defined by navigating to that cost item in that leg and activating the Scheduled checkbox. 
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From the main Estimate menu: 

1. Select Setup > Job Properties.

NOTE: Superior cost items are always scheduled using Plug Days. 

2. Click on the Schedule tab; then click on the Cost Item Roll Up tab.
3. Select the Automatically calculate Plug Days when rolling up cost items for scheduling

purposes checkbox.
4. If you want the superior level cost item (the cost item to which subordinates are rolled up) to

use the longest number of scheduled days from the subordinates as the duration,
choose Longest scheduled days among all rolled up cost items.

5. If you want the superior level cost item (the cost item to which subordinates are rolled up) to
use the total scheduled days of all subordinates as the duration, choose Total scheduled days
for all rolled up cost items.

NOTE: 
When rolling up cost items for scheduling purposes, the Plug Days of the superior cost 
item will be recalculated when a change is made to the scheduled days of a 
subordinate. 

6. To force an immediate recalculation of Plug Days for superior cost items, click the Recalculate
Plug Days button. Alternatively, you can use the More Actions > Calculate Plug Days command
on the Cost Breakdown (CBS) Register.
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Installing the Mobile Timesheets Module 

The Mobile Timesheets module enables you to collect employee, machine and period quantity data on 
the spot at the jobsite and instantly transmit that information back to the home office.  

The Timesheet Collector Client application can track employee and machine hours and charge them to 
specific job’s cost items or cost accounts instantaneously.  

The Timesheet Collector application includes synchronization capability that loads the master data from 
Estimate projects, such as standard codes for cost items, accounts, employees and machines (for 
example, employee codes, payroll types and resource rate codes) and tags. You never have to memorize 
the codes and can easily enter data from the display's lists. 

The Timesheet Collector application allows you to enter timesheet data using a disconnected laptop, 
then synchronize the data to the home office once a connection to either the Internet or the company 
network is available. For example, a foreman can enter timesheet data while at the jobsite, and then 
synchronize with the home office at the end of the day – either by initiating a wireless Internet 
connection, connecting to the Internet from home, or returning to the office and connecting to the 
company network.  

The Timesheet Collector Client allows timesheets to be recorded electronically, off-line, and requires 
only a minimal, temporary connection to the Internet or the company network to synchronize with the 
home office and transmit timesheet data. Once synchronized into the Timesheet Warehouse, the 
timesheet data is immediately available for approval and analysis by other Estimate users on the 
network.  
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The Mobile Timesheets module requires three additional components to an existing Estimate network 
environment: 

• Database: On the database server, running the Databases installer creates an additional
database named HDExecute. The HDExecute database must reside in the same SQL Server
instance used by the main Estimate application to hold jobs and the library. Physical database
files must reside in the same folder where jobs are stored.

• Timesheet Integration Server: On an application server, running the Timesheet Integration
Server installer sets up the Timesheet Integration Server.

• Timesheet Synch Handler: On the Web server, running the Timesheet Synch Handler installer
sets up a web application under your default website. By default, the application is named
HDTime, but it can be renamed during installation if you choose. The Timesheet Synch Handler
application is accessible only to authenticated network users. The site can be made accessible
outside the firewall or can be limited to access by users with an internal network connection.

Preparing for Installation of Mobile Timesheets 

Prerequisite Environment 

The Mobile Timesheets module should be installed after the main Estimate Client-Server application has 
been installed. The installation and setup instructions that follow assume a functioning environment 
that includes: 

• An installation of the Estimate server (running the InEight Estimate Server service)

• An installation of SQL Server 2014 Express Edition which can be installed when installing the
Estimate server application or an Estimate Database Server running full SQL Server 2005 – 2014

NOTE: 
If you will also be installing the Data Warehouse modules, you will be required to 
have a dedicated database server running full SQL Server 2005 – 2014. This database 
server will also be used for the Mobile Timesheets module. 

• An installation of the License Server (running the InEight Estimate License Server service)

If you are currently using a local Express Edition HDBID instance and will be moving to a full SQL Server 
instance on a dedicated database server, you will be required to migrate all job and library databases 
from the Express Edition instance to the full SQL Server instance on the dedicated database server.  

Once you have migrated the jobs and library databases to the dedicated SQL Server database server, 
verify that you can still run the Estimate application on client computers, and work with jobs and library 
data now residing on the dedicated database server. 
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Pre-Configured Web Server 

The Mobile Timesheets module requires a Web server running IIS. These instructions assume you have 
a Windows Server with IIS already installed. The server must have network connectivity with the 
Estimate Database Server (or the Estimate Server if you are using SQL Server 2014 Express Edition). 

Backup Considerations 

The Estimate Client-Server application has user initiated System Backup and Restore features. If you are 
using a full SQL Server instance and a dedicated database server for the Mobile Timesheets module 
rather than SQL Server Express Edition, these features are not appropriate when job and library 
databases reside on a separate SQL Server.  

If you are using a full SQL Server instance and a dedicated database server for the Mobile Timesheets 
module rather than SQL Server Express Edition, after you install the Mobile Timesheets module, you will 
need to rely on external Backup/Restore software to back up Estimate database files. 

Security Considerations 

Overview of Authentication in Estimate 

Estimate installations may span across multiple servers which must be able to communicate with one 
other. For example:  

• Services and Web applications require read & write access to databases.

• Services that attach & detach database files require the SQL Server sysadmin role.

• Services that start & stop SQL Server require the SQL Server sysadmin role.

• Services and Web applications require read access to folders where application files reside.

Every service and Web application is assigned an “identity” under which it runs. 

• For a Service: the identity is defined on the Log On tab in the service’s Properties dialog.

• For a Web Application: the identity is defined by assigning the application to an application
pool, and then defining the application pool’s identity in the pool’s Advanced Settings.

By default, services use identities that only have access to the local machine, such as the local System 
account. Local accounts cannot access resources on other computers. Since Estimate components must 
access resources (e.g., folders, files or service commands) on other computers, the default identities for 
all Estimate services must be changed.  

Recommended: Create a single network account for Estimate in Active Directory, and use it for all 
Estimate services. Give the account “Log on as a service” rights. On the Estimate SQL Server, add this 
account as a SQL Login and grant it the sysadmin role.  

Recommended: For Estimate Web applications, use the ASP.NET v4.0 application pool or create a new 
one just like it, and let that application pool use its own ApplicationPoolIdentity. Define credentials for 
accessing SQL Server in the application’s web.config file. 
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Timesheet Synchronization Web User Authentication Method 

The Timesheet Synchronization web application is designed to use Integrated Windows Authentication 
to allow user access. To access the site, a user who is not already logged on to the network (or the web 
server itself) will have to provide a user name and password. 

Mobile Timesheets Planning Worksheet 

Complete the following planning worksheet prior to installing the Mobile Timesheets Module. 

Database Connections 

DB. 1 What is the name of your Estimate database server 
computer?  

DB. 2 What is the SQL Server instance name? 
DB. 3 Where will your data be stored?  

Your database and log files must reside in the same 
folder where your Estimate jobs and library data reside. 
The default location is C:\Program Files\InEight\ InEight 
Estimate\Jobs on the database server.  

DB. 4 What SQL Server login will your Mobile Timesheets Web 
server use to connect to the SQL Server?  
Create this SQL Server login in advance. Make note of 
the user name and password.  

Mobile Timesheets Application Settings 

W. 1 What is the name of your Estimate Web server computer? 
W. 2 Under what website will you create the Mobile 

Timesheets application?  
By default, the Default Web Site will be used, but you can 
specify a different site during installation.  

W. 3 What will you name the Mobile Timesheets application? 
(The default name is HDTime).  

W. 4 What application pool will the application be assigned to? 
W. 5 Where will you place the Mobile Timesheets home 

directory? (The default location is 
C:\inetpub\wwwroot\Hard 
Dollar\TimesheetSyncHandler.)  

W. 6 What is the name of the computer where the InEight 
Estimate License Server runs?  
By default, the License Server uses port 8010.  
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Installing the Timesheet Integration Server 

The Timesheet Integration Server is required for the Mobile Timesheets module. The Timesheet 
Integration Server can be installed on a dedicated server or on a server that contains other Estimate 
applications.  

1. Start Windows as you normally would, then exit out of any programs that are currently running.
2. Launch the Estimate installer downloaded from the InEight website:
3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make

changes to your computer.
4. On the Installation Package screen, click the Install button to continue.
5. Click Install Estimate to continue.
6. At the License Agreement screen, select "I Accept the Agreement". Then click Continue to

continue.
7. If other Estimate client or server applications have already been installed on the server, select

Install on the Upgrade or Install dialog and click Next > to continue.
8. At the Components screen under Third Party Integration Components, select the Timesheet

Integration Server checkbox, and click Next > to continue.
9. If you are installing the Timesheet Integration Server on a server where no other Estimate

applications are installed, at the Select Destination Location screen, define the installation
folder for the Timesheet Integration Server. To accept the default installation folder, you do not
need to do anything. To define a different installation folder, click on the Browse button and
navigate to the desired folder. Click Next > to continue. Click Install to start the installation.

10. At the Ready to Install dialog, click Install to continue.
11. At the Update Registry and Finalize screen, click Next > to continue.
12. Click Finish to complete the Timesheet Integration Server installation and exit the setup

program.
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Installing the HDExecute Database 

Complete the following steps to install the HDExecute database. Where indicated, refer to your 
completed planning worksheet above. 

NOTE: 

The Estimate HDLibrary database must be attached in order for the new HDExecute 
database to install successfully. Normally, if the InEight Estimate Server service is 
started, HDLibrary will be attached. Use SQL Server Enterprise Manager or SQL Server 
Management Studio (depending on the version of SQL Server that you are using) to 
verify HDLibrary is attached. 

1. Log on to the database server as the machine administrator.
2. Launch the Estimate installer downloaded from the InEight website:
3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make

changes to your computer.
4. On the Installation Package screen, click the Install button to continue.
5. Click the Install Databases button.
6. At the License Agreement screen, select "I Accept the Agreement" and click Next > to continue.
7. At the Install Databases screen under the Database Selections section, select the HDExecute

database checkbox.
8. Under the Connection Information section, enter the SQL Server Host Name (from worksheet

line DB.1), and the SQL Server Instance (from worksheet line DB.2.).
9. At the Jobs/Databases Folder Path screen, enter the location for the HDExecute database files

(from worksheet line DB.3). Click Next > to continue.
10. At the Components screen, verify that Timesheet Collection Data is enabled and selected. Click

Next > to continue.
11. Click Install. Setup will install the HDExecute database, and run scripts to create stored

procedures and initialize tables.
12. When the installation has completed successfully, click Finish. Then Exit to leave the setup

program.
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Installing the Timesheet Synch Handler 

The Timesheet Synch Handler is required for the Mobile Timesheets module. The Timesheet Synch 
Handler should not be installed on any Estimate Server System. It can be installed on a dedicated Web 
server or on a Web server that contains other Estimate Web applications.  

NOTE: 

IIS must be installed/present on the client machines first for Estimate to allow you to 
install the Timesheet Synch Handler. To install IIS, go to your Windows Start Menu 
search bar, search for Turn Windows Features On or Off. Scroll down to the section 
Internet Information Services. Select the + sign to the left of the IIS section. Then 
select all items within the dropdown. Windows will then install IIS. 

1. Start Windows as you normally would, then exit out of any programs that are currently running.
2. Launch the Estimate installer downloaded from the InEight website:
3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make

changes to your computer.
4. On the Installation Package screen, click the Install button to continue.
5. Click Install Estimate to continue.
6. At the License Agreement screen, select "I Accept the Agreement". Then click Continue to

continue.
7. If other Estimate client or server applications have already been installed on the server, select

Install on the Upgrade or Install dialog and click Next > to continue.
8. At the Components screen under Timesheet Collector Components, select the Timesheet Synch

Handler checkbox, and click Next > to continue.
9. At the Select Destination Location screen, define the installation folder where the Timesheet

Synch Handler application will be installed. To accept the default installation folder, you do not
need to do anything. To define a different installation folder, click on the Browse button and
navigate to the desired folder.

10. At the Ready to Install dialog, click Install to continue.
11. At the Timesheet Sync Handler / IIS Preparation screen, configure the Web Site, Protocol, Port,

and Application settings.
12. Select Next > to continue with the install.
13. At the Start Web Site? Dialog, you can choose to either:

o Confirm the configuration of the Default Web Site by overriding the recommendation
and starting the site now by selecting Yes or

o Launch the Internet Information Services Manager

14. Either answer will complete the Timesheet Synch Handler installer and Launch the IIS
Management Console.

15. View Advanced Settings for the HDTime application. Set the Application Pool according to your
planning worksheet line W.4.

16. Open the Authentication feature for the HDTime application. Verify that Anonymous
Authentication is disabled and Windows Authentication is enabled.
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17. In the menu on the right, under Actions click Explore. This opens the C:\inetpub\wwwroot\Hard
Dollar\TimesheetSyncHandler folder.

18. Edit the web.config file. Near the bottom is a section that points to your HDExecute database:
19. <appSettings>
20. <add key="HDExecuteConnectionString" value="SERVER=(local)\HDBid;User ID=bidbuilduser;

Password=bidbuilduser;DATABASE=HDExecute"/>
21. <add key="DeviceDataQueryTimeout" value="300"/>
22. <add key="TimesheetServiceHost" value="localhost"/>
23. <add key="TimesheetServicePort" value="8020"/>
24. </appSettings>
25. Change the HDExecuteConnectionString values to point to your SQL Server instance using your

database login, as specified in DB.1, DB.2 and DB.4 in the table above.
26. Close the IIS Management Console.
27. Launch Internet Explorer. Enter http://<webserver name>/hdtime in the Address bar, and click

Go. Verify that the HDTime landing page is displayed.

NOTE: 

IIS performs Just-in-time (JIT) compiling of Web applications whenever they are 
initially launched, when IIS is restarted, or when IIS detects changes in the application 
path that trigger a re-compile. The first user that accesses the site when re-compiling 
will experience a delay. 

NOTE: 

Remote users can access the http://<webserver name>/hdtime page to download 
the Timesheet Collector installer. Instruct these users to enter <webserver 
name>/hdtime in the Server field (without the http://), when they synchronize with 
the Timesheet Warehouse. 

Installing the Timesheet Collector Client (PC Running Microsoft 
Windows) 

The Estimate Timesheet Collector Client is installed when the primary purpose of the user is to 
download master data from the main Estimate Server, create timesheets, and synchronize the 
timesheets up to the Timesheet Warehouse. A Timesheet Collector Client installation includes the 
installation of SQL Server 2014 Express Edition.  

The Estimate Timesheet Collector Client application can be installed by accessing the Internet and 
downloading the Estimate software then selecting the Timesheet Collector Client installation files. 

Prior to installing the Estimate Timesheet Collector, you must install the following applications to allow 
for synchronization with the main Estimate system  

• Estimate Server
• Estimate License Server
• Timesheet Integration Server
• Timesheet Synchronization Server
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Installing the Timesheet Collector Client from the Estimate Installation 

At each client workstation where the Timesheet Collector Client will be installed: 

1. Start Windows as you normally would, then exit out of any programs that are currently running.
2. Launch the Estimate installer downloaded from the InEight website:
3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make

changes to your computer.
4. On the Installation Package screen, click the Install button to continue.
5. Click Install Estimate to continue.
6. At the License Agreement screen, select "I Accept the Agreement". Then click Continue to

continue.
7. If other Estimate client or server applications have already been installed on the server, select

Install on the Upgrade or Install dialog and click Next > to continue.
8. At the Components screen under User Workstation Components, select the Estimate Client

checkbox.
9. Scroll down to the Timesheet Collector Components and select the Timesheet Collector check

box.
10. Click Next > to continue.
11. At the Select Destination Location screen, define the installation folder where the Timesheet

Collector Client application will be installed. To accept the default installation folder, you do not
need to do anything. To define a different installation folder, click on the Browse button and
navigate to the desired folder.

12. At the Ready to Install screen, click Install to continue.
13. Click Next > to continue.
14. At the Select Additional Task screen, click Next > to have the setup program automatically

create a desktop and quick launch icon for the Timesheet Collector Client. If you do not want
the setup program to install these shortcuts, uncheck the appropriate checkbox and click Next >
to continue.

15. At the Installation Summary screen, click Next > to continue.
16. Click Finish to complete the installation and exit the setup program.
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Installing the Data Warehouse 

The Data Warehouse allows you to combine data from multiple, individual job databases into a single 
database for reporting purposes. You select which jobs to include and whether you want to update the 
Data Warehouse automatically when any of the selected jobs are saved, or manually at your discretion. 
With the data consolidated into the Data Warehouse, you can then use Crystal Reports, Microsoft 
Access, or any other SQL-compatible reporting tool to create user-defined reports that span across jobs. 

The Data Warehouse requires two additional components to an existing Estimate network environment: 

• Database: On the database server, an additional database named HDWarehouse is created. This
database can become very large, and is a heavy consumer of system memory and disk I/O. For
optimal performance, the HDWarehouse database should reside on a SQL Server computer
separate from the SQL Server computer where Estimate jobs and the HDExecute database are
stored.

• Job Consolidation Server: On an application server, running the Job Consolidation Server
installer sets up the Job Consolidation Server.

• Job Consolidation: Runs as a service, connects as a client to the InEight Estimate Server, just as
Estimate users do when they run the main application. You can use the Data Warehouse feature
within the Estimate client application to select which jobs should be consolidated into the Data
Warehouse. This can be located by navigating to File > Jobs > Data Warehouse.

For optimal performance, the Job Consolidation Server should be installed on a dedicated server. 
Optionally, it can be installed on the same application server where other Estimate services run (e.g. the 
License Server, the Timesheet Integration Server, or the InEight Estimate Server.)  

Preparing for Installation of the Data Warehouse 

Prerequisite Environment 

The Data Warehouse database should be installed after the main Estimate client/server application has 
been installed. The installation and setup instructions that follow assume a functioning environment 
that includes:  

• An installation of the Estimate Server (running the InEight Estimate Server service)
• An Estimate Database Server running full SQL Server 2005 – SQL Server 2017.
• An installation of the License Server (running InEight Estimate License Server service)

A full SQL Server instance on a dedicated database server is required for the Data Warehouse. 

Backup Considerations 

The Estimate client/server application has user initiated System Backup and Restore features. These 
features are not appropriate for Estimate Enterprise implementations, where job and library databases 
reside on a separate SQL Server, and additional databases exist for modules such as Mobile Timesheets 
and the Data Warehouse. After you install the Data Warehouse, you will need to rely on external 
Backup/Restore software to back up Estimate database files. 
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Security Considerations 

Overview of Authentication in Estimate 

Estimate installations may span across multiple servers which must be able to communicate with one 
other. For example:  

• Services and Web applications require read & write access to databases.
• Services that attach & detach database files require the SQL Server sysadmin role.
• Services that start & stop SQL Server require the SQL Server sysadmin role.
• Services and Web applications require read access to folders where application files reside.

Every service and Web application is assigned an “identity” under which it runs.  

For a Service: the identity is defined on the Log On tab in the service’s Properties dialog. 

For a Web Application: the identity is defined by assigning the application to an application pool, and 
then defining the application pool’s identity in the pool’s Advanced Settings.  

By default, services use identities that only have access to the local machine, such as the local System 
account. Local accounts cannot access resources on other computers. Since Estimate components must 
access resources (e.g., folders, files or service commands) on other computers, the default identities for 
all Estimate services must be changed.  

Recommended: Create a single network account for Estimate in Active Directory, and use it for all 
Estimate services. Give the account “Log on as a service” rights. On the Estimate SQL Server, add this 
account as a SQL Login and grant it the sysadmin role.  

Recommended: For Estimate Web applications, use the ASP.NET v4.0 application pool or create a new 
one just like it, and let that application pool use its own ApplicationPoolIdentity. Define credentials for 
accessing SQL Server in the application’s web.config file. 

Data Warehouse Planning Worksheet 

Complete the following planning worksheet prior to installing the Data Warehouse. 

Job Consolidation Settings 

RW. 1 What is the name of the Estimate application server where the Job 
Consolidation service will be installed?  

RW. 2 What is the name of the computer where the InEight Estimate Server 
service runs?  

RW. 3 What is the name of the database server computer where HDWarehouse 
will be stored?  
This database can become very large, and is a heavy consumer of system 
memory and disk I/O. For optimal performance, the HDWarehouse 
database should reside on a SQL Server computer separate from the SQL 
Server computer where Estimate jobs and the HDExecute database are 
stored.  

RW. 4 What is the SQL Server instance name? 
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RW. 5 Do you want to allow the Job Consolidation service to attach the 
HDWarehouse database if it becomes detached? (This requires sharing 
the data folder on the SQL Server, and giving access to the Job 
Consolidation login identity. It also requires granting the sysadmin role, in 
SQL Server, to this login identity.)  

RW. 5.1 If yes, share the data folder in advance, and document the share name. 
Permit the Estimate network login Full Control.  

RW. 5.2 If no, be aware that the Job Consolidation service will fail to start 
whenever HDWarehouse is not attached. An error will appear in the 
JobConsolidationServer.log file.  

RW. 6 Where will your Data Warehouse data be stored?  
Create a folder to contain database data and log files. You will most likely 
want to select a different location than the default application folder, 
because Estimate applications are not likely to be installed on the 
database server.  

RW. 6.1 What is the path to this data folder, from the database server’s 
perspective?  
For example, if the files on the SQL Server are at C:\HD Data, then from 
the SQL Server’s perspective, the path is exactly that: C:\HD Data.  

RW. 6.2 What is the path to this data folder, from the application server’s 
perspective?  
For example, if the files on the SQL Server are at C:\Estimate Data, and 
that folder is shared as EstimateData, then from the application server’s 
perspective the file path is \\<dbserver>\estimatedata.  

RW. 7 How many jobs should the Job Consolidation server be allowed to update 
in the Data Warehouse, at one time?  
By default, Job Consolidation will update 2 jobs at once. Other jobs wait 
in queue. Larger jobs require more memory, so this setting can be 
adjusted according to the typical size of your Estimate jobs, and according 
to how much memory is available on your Job Consolidation server. The 
default is 2 (minimum 1, maximum 10).  

Installing the Job Consolidation Server 

The Job Consolidation Server is required for the Estimate Benchmarking feature and the Data 
Warehouse database. The Job Consolidation Server can be installed on a dedicated server or on a server 
that contains other Estimate applications.  

When Job Consolidation is used to update the Data Warehouse, installing Job Consolidation on its own 
server computer is strongly recommended.  

1. Start Windows as you normally would, then exit out of any programs that are currently running.
2. Launch the Estimate installer downloaded from the InEight website:
3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make

changes to your computer.
4. On the Installation Package screen, click the Install button to continue.
5. Click Install Estimate to continue.
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6. At the License Agreement screen, select "I Accept the Agreement". Then click Continue to
continue.

7. If other Estimate client/server applications have already been installed on the server, select
Install on the Upgrade or Install dialog and click Next > to continue.

8. At the Components screen under Enterprise Server Components, select the Job Consolidation
Server checkbox, and click Next > to continue.

9. If you are installing the Job Consolidation Server on a server where no other Estimate
applications are installed, at the Select Destination Location screen, define the installation
folder for the Job Consolidation Server. To accept the default installation folder, you do not
need to do anything. To define a different installation folder, click on the Browse button and
navigate to the desired folder. Click Next > to continue.

10. Click Install to start the installation.

NOTE: If you are installing the Job Consolidation Server on a dedicated server, the Estimate 
Framework will also be installed. 

11. On the Configuration Tool dialog, select the Network tab if it is not already selected.
12. In the Server IP Address or DNS Name field, enter the name of the computer where the InEight

Estimate Server service runs (from worksheet line RW.2).
13. Select the Job Consolidation tab.
14. Select the Enable Data Warehouse checkbox.
15. In the Maximum Concurrent Jobs field, choose the number of jobs that can be updated

concurrently in the Data Warehouse (from worksheet line RW.7).
16. If applicable, check the box to Use Separate Database Server.
17. If applicable, in the Server Host Name field, enter the name of the database server computer

where the HDWarehouse database will be stored (from worksheet line RW.3).
18. If applicable, in the Instance name field, enter the SQL Server instance name (from worksheet

line RW.4).
19. If preferable, in the Database Security data block, if you want the Job Consolidation Server

service to connect to the database using its runtime identity (see worksheet line RW.5.1), select
Use Window Authentication, or

20. If preferable, in the Database Security data block, if you want the Job Consolidation Server
service to connect to the database using SQL Server Authentication, uncheck Use Window
Authentication and enter the database User Name and database User Password (from
worksheet line RW.5.2).

21. In the Data Warehouse Paths data block, enter the Server Data File Path (from Database Server
perspective) from worksheet line RW.6.1.

22. In the Data Warehouse Paths data block, enter the Local Data File Path (from Job Consolidation
Server perspective) from worksheet line RW.6.2.

23. Click OK to continue.
24. At the Installation Summary screen, click Next > to continue.
25. Click Finish to complete the installation and exit the setup program.
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Installing the Estimate OnCenter Integration Module 

NOTE: If you are installing the integration on a server, the InEight Estimate Server service will 
restart at the end of the installation process. 

Complete the following steps to install the Estimate OnCenter Integration module. 

1. Start Windows as you normally would, then exit out of any programs that are currently running.
2. Launch the Estimate installer downloaded from the InEight website:
3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make

changes to your computer.
4. On the Installation Package screen, click the Install button to continue.
5. Click Install Estimate to continue.
6. At the License Agreement screen, select "I Accept the Agreement". Then click Continue to

continue.
7. If other Estimate client/server applications have already been installed on the server, select

Install on the Upgrade or Install dialog and click Next > to continue.
8. On the Components screen under Third Party Integration Components, select the OnCenter

checkbox and click Next >.
9. At the Select Destination Location screen, define the installation folder for the OnCenter

integration. To accept the default installation folder, you do not need to do anything. To define
a different installation folder, click on the Browse button and navigate to the desired folder.
Click Next > to continue. Click Install to start the installation.

10. On the Ready to Install dialog, click INSTALL to continue.
11. At the Installation Summary screen, click NEXT > to continue.
12. Click FINISH to complete the installation and EXIT the setup program.
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Installing the Estimate InfoMine Integration Module 

Complete the following steps to install the Estimate InfoMine Integration module. 

1. Start Windows as you normally would, then exit out of any programs that are currently running.
2. Launch the Estimate installer downloaded from the InEight website:
3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make

changes to your computer.
4. On the Installation Package screen, click the Install button to continue.
5. Click Install Estimate to continue.
6. At the License Agreement screen, select "I Accept the Agreement". Then click Continue to

continue.
7. On the Components screen under Third Party Integration Components, select the InfoMine

checkbox and click Next >.
8. At the Select Destination Location screen, define the installation folder for the InfoMine

integration. To accept the default installation folder, you do not need to do anything. To define
a different installation folder, click on the Browse button and navigate to the desired folder.
Click Next > to continue. Click Install to start the installation.

9. On the Ready to Install dialog, click Install to continue.
10. At the Installation Summary screen, click NEXT > to continue.
11. Click FINISH to complete the installation and EXIT the setup program.
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